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Installing KNIME Analytics Platform


For step-by-step videos on how to install KNIME Analytics Platform, please take

a look at our KNIMETV YouTube channel.

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.
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Figure 1. KNIME Analytics Platform versions

4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

 Also check the KNIME Quickstart Guide and the KNIME Workbench Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions by:

• Clicking File on the menu bar and then Install KNIME Extensions…. The dialog shown in

Figure 2 opens.

• Selecting the extensions you want to install

• Clicking Next and following the instructions

• Restarting KNIME Analytics Platform
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Figure 2. Installing Extensions and Integrations

The Install KNIME Extensions menu provides the extensions that are available via the update

sites you have enabled.


For more information, take a look at our video on How to Install Extensions in

KNIME Analytics Platform. Also see the Extensions and Integrations Guide.

To uninstall an extension, click Help, About KNIME Analytics Platform, and then Installation

Details. A dialog shown in Figure 3 opens. Now, select the extension that you want to

uninstall, and click Uninstall….
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Figure 3. Uninstalling Extensions and Integrations
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Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking File → Update KNIME…. In the dialog that opens, select the available updates

you want to install and then click Next.

2. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, select File → Preferences →
Install/Update → Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 4. Available Update Sites

KNIME Analytics Platform 4.1 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Extensions: Provides

extensions created by KNIME partners.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Analytics Platform 4.1 Update Site and KNIME Community Extensions (Trusted) are

enabled by default.
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Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 5.

Figure 5. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file. You can download KNIME update sites

as zip files here.

• Save the zip file containing the extensions to your local system

• Select File → Preferences → Install/Update → Available Software Sites and enter the

path to the zip file by clicking Add → Archive… as shown in Figure 6.

KNIME Analytics Platform Installation Guide

© 2018 KNIME AG. All rights reserved. 9

https://update.knime.org/analytics-platform/UpdateSite_latest41.zip


Figure 6. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable the

update site by disabling it in the list.

• Now click Apply and Close



If the same extensions are also provided by a remote update site, you will first

have to disable that update site by deselecting its entry in the Available

Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Changelog (KNIME Analytics Platform 4.1)

Detailed changelog for v4.1.x releases

KNIME Analytics Platform 4.1.0

(see highlight summary)

Release date: December 06, 2019

New nodes

• AP-8200: Send to Power BI

• AP-8088: Google BigQuery Connector

• AP-9465: Google Cloud Storage (2 nodes)

• BD-963: Create Databricks Environment

• BD-961: Databricks File System Connection

• AP-12995: Integration of Amazon Personalize services

• AP-13290: MDF Reader — Measurement Data Format

• AP-12705: Split Density Scorer into Updater and Scorer

• AP-12703: Add Active Learning Loop

• AP-11817: H2O Integration: Add H2O MOJO Predictor (Isolation Forest) node

• AP-12694: Excel Writer (new file handling)

• AP-12688: Excel Reader (new file handling)

• AP-13051: Line Reader (new file handling)

• AP-12652: Weak Label Model Learner and Predictor

• AP-10631: Run R Model in Microsoft SQL Server (new db framework)

• AP-12324: Nominal Probability Distribution Creator and Splitter

• AP-12189: DB Connection Closer

• AP-11954: DB Connection Extractor

• AP-10256: Amazon Athena Connector (new)

• AP-12788: Webpage Retriever

• AP-7928: Silhouette Coefficient
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• AP-12336: Top K Selector Node

• AP-11964: Row Filter (Labs) — supporting multiple, more advanced search criteria

• BD-735: Vertica Connector (new)

Enhancements

• AP-13232: Ensure a menu item for the Node Monitor in the View menu

• AP-13219: Add option to Boolean Widget and Configuration nodes to push flow variable

of type boolean

• AP-13066: Select background when opening a component

• AP-13049: Add success message after successfull deployment of preferences

• AP-13038: Component metadata editor

• AP-12998: Show DB Meta Data Browser in DB Table Selector when custom query is

enabled

• AP-12988: Make input ports of concatenate node configurable

• AP-12959: Add visual indicator for nodes whose ports are configurable

• AP-12953: Show "Recent Workflows" under "File" menu

• AP-12947: Pass NodeCreationConfiguration to createNodeDialogPane

• AP-12945: Allow to disable DB Data port in DB Manipulation nodes

• AP-12943: Support none local KNIME URL resolving in JDBC parameters

• AP-12939: Allow earlier garbage collection of cached tables

• AP-12928: Allow garbage collection of in-memory tables that are being iterated over

• AP-12881: Text Processing: Arabic language support

• AP-12809: Enable flow variables of type boolean, long, array for Table Row/Column to

Variable and Variable to Table Row/Column node

• AP-12786: Implement new File Handling Port Type

• AP-12783: Implement Nominal Probability Distributions with Metadata

• AP-12747: Support Probability Distribution Values in Uncertainty Scorer Nodes

• AP-12746: Modify NodeFactoryClassMapper to expose mappings

• AP-12744: Suggest URL template for known db types

• AP-12740: Component editor with example data

• AP-12706: Probability Distribution Creator: One-hot encoding of String columns
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• AP-12665: Create Temp Directory node should create directory inside workflow

• AP-12660: Implement responsive design for welcome page

• AP-12657: Support TLS1.2 in the Send Email node

• AP-12651: Label model: Calculate covariance matrix in KNIME

• AP-12650: Support probabilistic Inputs in the Label Model

• AP-12645: Table Reader Node to have timeout option (important when reading from

remote resources)

• AP-12643: Improved JDBC URL template UI

• AP-12636: DB transaction management including Start and End Transaction node

• AP-12615: Rank/Linear Correlation: save p-value and degrees of freedom in correlation

model

• AP-12567: Configurations and Widgets: improve error message on variable name

starting with "knime"

• AP-12561: Support loading of a native library per user defined JDBC driver

• AP-12553: Cache static model contents of density scorer models

• AP-12531: Untangle Testing Framework feature

• AP-12514: Let Label Model output probabilistic labels

• AP-12503: Workflow migration tool tooltip

• AP-12482: Write code-base allowing to add/remove ports to/from standard nodes

• AP-12480: Allow multiple table views within one view

• AP-12473: CSV Writer: Make comment header indentation optional

• AP-12463: Switching to "Welcome Page" should clear Description View

• AP-12462: Restrict metadata editor link types via pulldown

• AP-12338: Rewrite Potential Uncertainty Scorer Node

• AP-12325: Custom Renderer for Probabilistic Labels

• AP-12323: Probability Distribution Cell

• AP-12308: Revise Exploration/Exploitation Scorer (Rename to Exploration/Exploitation

Score Combiner)

• AP-12306: Rewrite Graph Density Uncertainty Scorer Node

• AP-12296: Enhance Logistic Regression to support a probabilistic target column

• AP-12295: Enhance Gradient Boosted Trees to support a probabilistic target column
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• AP-12294: Revise Uncertainty Scorer Nodes

• AP-12241: Change default settings of the Partitioning nodes

• AP-12194: Add flow variable support to DB Table Selection component

• AP-12120: Drag’n’drop of workflow from Hub

• AP-11962: Allow to disable DB connection recreation on workflow loading

• AP-11949: Improve node description of the Feature Selection Loop Start nodes

• AP-11943: Improved error messaging on Components (e.g. when contained nodes are

not fully connected or fail on execution)

• AP-11916: Remove annotation border menu and toolbar items for node annotations

• AP-10906: H2O Integration: Support MOJOs of category 'Ordinal'

• AP-10119: H2O Integration: Add option to treat unknown categorical values as NA to

MOJO predictors

• AP-10030: Rank/Linear Correlation: show p-values and number of cases for each

correlation

• AP-9891: Improve usability of Zooming

• AP-9722: Add more space to the workbench to the bottom and right (additional space

when moving or adding nodes)

• AP-9338: JavaScript Line Plot with option to start x and y axis at 0 and not at minimum

• AP-8357: H2O Integration: Improve tool tips of H2O ports and labels/layout in H2O

frame view

• AP-7165: K-Means: Add option to randomly select initial centroids

• AP-6747: List Remote Files: Update Node Description

• AP-5550: PMML Predictor should output probabilities and allow change of prediction

column name

• AP-3201: Additional flow variable types for boolean, long, and arrays

• BD-987: (Big Data Extensions): Allow custom configuration keys in custom Spark

settings of the Livy node

• BD-978: (Big Data Extensions): Support user name and password authentication in

Create Spark Context (Livy) node e.g. to connect to Azure HDInsight

• BD-971: (Big Data Extensions): Support Livy 0.6 in KNIME

• BD-949: (Big Data Extensions): Persistently save and display Kerberos username

• BD-766: (Big Data Extensions): Implement fallback solution for ORC/Parquet reader
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• BD-121: (Big Data Extensions): Add support for KNOX to Create Spark Context (Livy)

node

• BD-120: (Big Data Extensions): Add WebHDFS via KNOX Connector node

• BD-119: (Big Data Extensions): Add support for KNOX to Hive Connector node

Bug Fixes

• AP-13152: Unable to parse container.compression property Gzip (on system with

Turkish Locale)

• AP-13058: PCA node fails when large number of input columns are present

• AP-12931: SSH Connection does not resolve ~ on linux updating to 4.0

• AP-13234: KNIME doesn’t open with empty workspace (CentOS 6)

• AP-13230: Naive Bayes Model handles derived fields incorrectly

• AP-13224: PMML Transformation Applier fails when no TransformationDictionary is

present

• AP-13222: PMML Transformation Applier fails to apply missing value and/or

normalization model

• AP-13213: Slider Widget loads with JS error

• AP-13194: Metanode disappears when converting to component

• AP-13191: Right click on empty canvas does not deselect component

• AP-13183: NullPointerException when closing Parquet Table Store Reader

• AP-13156: Math Formula (Multi Column) does not seem to work with certain column

names

• AP-13127: Git Push node: Push tags checkbox in config dialog not configurable

• AP-13120: Column/Variable Expressions: Function selection dialog stays open after

closing configuration dialog

• AP-13112: Column Filter configuration validation does not import options created in 4.0

• AP-13097: NullPointerException when loading Workflow with Excel Reader node that

reads from Amazon S3

• AP-13096: Writing files to custom URL fails

• AP-13081: Close component metadata editor when left

• AP-13077: Edit "icon" missing when stepping into component after it has been unlinked

• AP-13075: Excel Writer has option to save file relative to workflow, but does not seem
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to support it

• AP-13070: Column Filter Configuration filters out all columns if the dialog is never

opened

• AP-13032: Loading org.knime.ext.ssh bundle slows KNIME start drastically (class

traversal issue)

• AP-13025: Gradient Boosted Trees to PMML produces invalid PMML in some cases

• AP-13005: Support setting alpha and beta to 0 for Tversky Distance

• AP-12980: DB manipulation nodes (Insert, Update, Merge, Delete, Writer) do not work in

loops

• AP-12960: BarChart highlights wrong row on selection

• AP-12933: Range Slider Filter Definition Node has rounding errors

• AP-12893: Flow Variable should be spelled correctly in the node port type

• AP-12892: Node annotation toolbar doesnt disappear when switching windows

• AP-12865: Custom URL does not work with file scheme

• AP-12864: DB Reader throws duplicate key exception when reading multiple binary

columns

• AP-12860: Typo in Update Components dialog

• AP-12843: Pie/Donut Chart can’t be configured if Number type column is not present in

table

• AP-12781: CSS styling not working for SVG output of Plotly nodes

• AP-12720: Random Forest progress seems stuck during the creation of the final trees

• AP-12712: Choosing KNIME FileSystem causes the Dialog to resize so that Browse

Button is not visible

• AP-12675: Windows Eclipse 4.7 does not support horizontal scrolling via scrollwheel

• AP-12670: Missing Value node description incorrect

• AP-12616: Rank Correlation: Rank output should be of type long not double

• AP-12613: Scroll bar resizes during scrolling in H2O and Spark table views for large

datasets

• AP-12606: When selecting <RowID> for the axis column in the Line Plot (Plotly) it fails

when executing

• AP-12526: Wrong port color displayed for BufferedDataTable ports on components

• AP-12523: Table Difference Checker ignores domain order
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• AP-12520: Mouse goes to upper left corner during loading of streamable nodes

• AP-12519: Color legend too small on Plotly Bubble Chart node

• AP-12515: New database feature added to knime-ap target platform

• AP-12220: Drag’n’drop problem with Image Processing nodes from Hub to AP

• AP-12109: Update File Reader node description

• AP-12079: Python: stderr messages should be logged to INFO unless they’re warnings

• AP-12062: DB Connector node: Database URL (if long) is not moving together with the

cursor to the end of the URL

• AP-11929: KNIME types without a mapping rule are shown in the Source Type

dropdown box

• AP-11525: Stacked Area Chart assigns colors based on column order instead of

column name

• AP-11269: Executed Keras Input Layer doesn’t work after upload and download from

server

• AP-10907: Support cancellation of fetch unique values query in DB Row Filter

• AP-10032: Remove duplicates in node repository

• AP-9290: Streamable Metanode can be reset during execution

• AP-9284: Problem restoring file store cells on re-loaded of executed and streamed

component

• AP-6364: Empty Table Switch fails in streamed node

• AP-6192: Streaming Wrapped nodes fails with NPE in inactive Branch

• BD-988: (Big Data Extensions): DB Loader for Hive has problems with input KNIME

tables that have non-word characters in their name

• BD-983: (Big Data Extensions): H2O nodes do not show string columns on Sparkling

Water

KNIME Analytics Platform 4.1.1

Release date: February 05, 2020

Enhancements

• AP-13403: Line Reader should allow user to specify encoding
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• AP-13401: Support new Google API specific endpoints

• AP-13300: Power BI: Support refreshing an existing dataset

• AP-13228: Power BI: Save unused dialog options to keep them in the dialog

• AP-12990: Power BI node - specify error message

• AP-12891: Send to Power BI: Take care of API limitations

Bug Fixes

• BD-1003: (Big Data Extensions): Table to Spark node fails on Spark Jobserver when

connecting from Windows

• AP-13588: Excel Writer node refuses write to mountpoint when running on KNIME

Server (new file handling)

• AP-13574: Credentials Input node doesn’t work when used in job pool on KNIME Server

• AP-13564: Ranger Slider Widget fails with certain settings, it did not in 4.0.2 (tested)

• AP-13555: knime.in cannot be properly initialized if model input contains variables

named F

• AP-13554: Labeling Widget has wrong warning message

• AP-13552: ClassCastException instead of error message when streamed component

contains metanode

• AP-13533: RXN/RD Reader execution fails while reading rd files with more than one

reaction

• AP-13527: IllegalArgumentException when reading from Custom URL that contains

spaces

• AP-13526: Power BI: Fix tracking if authentication is in progress

• AP-13525: Amazon Authentication and S3 Connection node cannot be configured to

use credentials

• AP-13519: Credentials Widget can not deserialize view value

• AP-13517: Line Reader node has resource leak

• AP-13486: Silhouette Coefficient: returns "NaN" as mean silhouette coefficient for

some clusters

• AP-13480: Our Windows fix for Eclipse not doing horizontal scrolling needs improving

• AP-13399: EXAMPLE and My-KNIME-Hub mountpoints not browseable revised

reader/writer nodes
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• AP-13398: Kerberos logging does not capture messages logged to standard out

• AP-13384: Replacing node via Drag and Drop swaps connections

• AP-13362: Reading files from folder in new file reader dialog component reads files in

filesystem-dependent order

• AP-13361: Default position of output ports bar in metanodes shifted to the to right after

upgrade to 4.1

• AP-13358: Label view produces String '?' instead of true missing values in output

column

• AP-13356: Label view 'clear selection' button only visually de-selects tiles

• AP-13354: Column Filter Widget is not displayed in node view for tables with many

columns

• AP-13353: Fix ui glitches in the labeling view

• AP-13348: Deprecated Excel Writer/Sheet Appender nodes fail with

InvocationTargetException

• AP-13347: Google Cloud and BigQuery scopes should not be available in Google

Authentication node

• AP-13346: File Download Widget blocks workflow when file does not exist

• AP-13341: Sometimes the second tile of the label view is initially selected instead of the

first tile

• AP-13325: Streamable source nodes are not correctly flagged as such anymore in node

repo

• AP-13318: NullPointerException when loading workflows with String flow variables of

value null

• AP-13316: H2O Integration: Partitioning node handles incorrectly an input column

named "split"

• AP-13309: MDF Reader: Linear integer interpolation option not respected

• AP-13303: Webpage Retriever fails with NAMESPACE_ERR

• AP-13292: Incompatibility of 'Binary Objects to Files' with network shares

• AP-13291: FilterPanel Dialog does not restore FilterExpression

• AP-13283: (Linux, certain flavors only:) AP potentially crashes when multiple

components are opened

• AP-13282: File systems requiring absolute paths should show error when relative path

is provided
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• AP-13281: Opening component from hub claims in a message that it’s showing a

remote workflow… but it’s a component

• AP-13278: Details text to "KNIME Extension providing Chromium" states wrong version

• AP-13267: Missing mountpoint causes NullPointerException

• AP-13203: Error when saving workflow that contains a previously executed node with

internal tables in an inactive branch

• AP-13125: Naive Bayes Predictor fails with "Mean hasn’t been calculated" when data

contains infinity

• AP-12676: H2O Integration: Race condition during partitioning

• AP-12656: Word metanode still used when checking if update available

• AP-11953: H2O Integration: DistributedException during parallel predictions

• AP-11873: "Normalizer", "Transformation", and "PCA" Ports Not Available in Component

Reconfiguration Dialog

KNIME Analytics Platform 4.1.2

Release date: March 05, 2020

Enhancements

• AP-13737: File upload (widget) should provide flow variable with knime:// URL

• AP-13585: Add preference to allow local file system access when running on KNIME

Server (new file handling)

Bug Fixes

• AP-13791: Errors such as during file browsing are not reported (new file chooser)

• AP-13789: Status message gets stuck in "Scanning" or disappears when typing Custom

URL (new file chooser in reader nodes)

• AP-13758: Configure in Reference Column Filter and Splitter slow for wide tables

• AP-13754: Generic JS View doesn’t load CSS dependencies in AP

• AP-13720: Line Reader/Excel Writer/Sheet Appender description update

• AP-13715: When "enable page size control" option is disabled menu button of labeling

widget does not work anymore
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• AP-13699: Excel sheet Appender uses non dynamic xml scheme

• AP-13675: Node Value of the deprecated Column Filter Widget can’t be deserialized

from JSON

• AP-13674: Credentials Input Quickform can not deserialize view value anymore

• AP-13673: Unresponsive Excel Writer when typing Custom URL (new file chooser)

• AP-13671: Workflow closes even if saving operation is not successful

• AP-13659: Excel Writer fails to write to Custom URL when "Overwrite existing file" is

selected

• AP-13570: First Workflow Credential/Variable not visible from dialog

• AP-13357: Labeling Widget exhibits strange scrolling behavior in Component View

• AP-13299: Import workflows wizard checkboxes settings are not saved

• AP-13237: Unresponsive Excel Reader dialog when typing a path for a remote

connection such as S3 (new file chooser)

KNIME Analytics Platform 4.1.3

Release date: May 13, 2020

Enhancements

• AP-14248: Legacy database framework supports multi-release driver jars

• AP-14063: (Windows) Executables, e.g. knime.exe, to be signed — less trouble during

installation and running on Windows 10

• AP-13920: Document Data Extractor with option to separate terms with spaces

• AP-13815: Tableau Hyper: Switch to the Hyper API

• BD-1021: (Big Data Extensions): Impala Connector (legacy) supports latest Cloudera

Impala driver

• BD-1020: (Big Data Extensions): Hive Connector (legacy) supports latest Cloudera Hive

driver

Bug Fixes

• AP-13847: Table does not unregister memory alert listeners on clear

• AP-13846: Encrypted shared components cannot be delete anymore via explorer
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• AP-14195: DialogComponentAuthentication does not support one character passwords

• AP-14118: Text Mining: Array Index out of Bounds Exception due to HTML escaping in

Spanish/PTBTokenizer

• AP-14104: Setting possible values as flow variable does not affect the view in the

labeling widget

• AP-14023: NPE thrown in saveInternals of Tag Cloud (non-js)

• AP-14007: Cell Replacer removes spec of collection columns

• AP-14004: Azure Blob Store Connector cannot read append blobs

• AP-13971: H2O locks up server on a rare occasion

• AP-13964: Encrypted components can be opened without password when they are

shared

• AP-13931: S3 server-side encryption (SSE) is not being used when creating a folder in

S3

• AP-13888: Labeling View not compatible in safari and firefox

• AP-13830: Power BI: Filter dataset that are not "Push" datasets in node dialog

• AP-13820: Power BI: Show authentication placeholder in dataset/table selection

• AP-13817: NPE in Webpage Retriever node if "Fail" disabled and illegal status code

received

• AP-13747: Integer Slider Configuration description mismatch

• AP-13686: MDF: Reading empty channel fails

• AP-13679: Tableau: Hyper Server did not call back

• AP-13342: Labeling fails when subscribing to other views published rows that are not in

the labeling widget displayed set.

• AP-12723: Polynomial Regression Learner Fails with boolean integer input

• AP-11787: H2O Integration: AssertionError in metanode execution

KNIME Analytics Platform 4.1.4

Release date: August 26, 2020

Bug Fixes

• AP-14876: Connection errors in I/O nodes when reading/writing from/to server in high

frequency
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• AP-14634: H2O Integration: Treat columns containing only missing values as being

constant

• AP-14316: Labeling view buttons disappear when reloading the view

• AP-14268: JSON Transformer Node works sometimes on wrong JSON column giving

wrong results

• AP-13763: Amazon Athena Connector node could not login without role switching

• AP-13748: Error when saving workflow with failure in Recursive Loop End

• AP-12858: H2O Integration: Fix minor bugs in Naive Bayes node dialog

• AP-12857: H2O Integration: Fix minor bugs in GLRM node dialog

• AP-12748: Component in inactive branch stops workflow

• AP-9868: Make "Lift Chart (JavaScript)" node responsive

• AP-6268: Components cannot be used with Try Catch nodes

General Release Notes

Developers of community and other custom extensions should pay attention to the following:

• Testing framework restructured into different repositories (contact us if you have

dependencies to; org.knime.testing, org.knime.testing.headless, org.knime.testing.ui, or

org.knime.js.testing)

• Interested in using the dynamics ports feature mentioned above? Have a looked at the

Concatenate Node.

• The new flow variable API (as per AP-12809) focuses on extensibility and takes care of

maintaining backwards compatibility. It enables the implementation of custom flow

variable types by extending an abstract class. (Currently!) available types are defined

here, usage in individual nodes are done following these methods (1, 2)
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https://forum.knime.com/c/knime-development/21
https://github.com/knime/knime-base/blob/d48da08bc6d11b36024c685fdadd21b957920481/org.knime.base/src/org/knime/base/node/preproc/append/row/AppendedRowsNodeModel.java
https://github.com/knime/knime-core/blob/71b0355e572d0c1c57329dc9e416c83dae097154/org.knime.core/src/eclipse/org/knime/core/node/workflow/VariableType.java#L683
https://github.com/knime/knime-core/blob/d4de6e6531d23dbe5e041538c0ea55b3a99c82b2/org.knime.core/src/eclipse/org/knime/core/node/NodeModel.java#L1300
https://github.com/knime/knime-core/blob/d4de6e6531d23dbe5e041538c0ea55b3a99c82b2/org.knime.core/src/eclipse/org/knime/core/node/NodeModel.java#L1339
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